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FED3+: Installation Space

¢, FED3+ installaticn space - O *
litt angle alpha b |45 ’
Length Lkmax |30 mmo |4
Lenath Lkmin mm £
outside diameter (bore] De max |50 mmo |4
inzide diameter [mandrel] Dimin |15 mmo <

spring load M1 min |430.5 MNmm | £

A AT

spring load M1 max 500 Mmm | <
zpring load M2 min Mmm | <
spring load M2 max Mmm | <
M <= irch

Cancel Aug. Image Help Text Calc

Similar to FED1+, you can now also enter an installation space in FED3+ and cal cul ate thousands
of springs with different wire diameters, coil diameters and coil numbers. From the cal culated
variants, you can then choose the optimum torsion spring for the respective application (maximum
safety, lowest weight, smallest length, maximum resonance frequency, smallest tolerance of torque
according to DIN 2194).

FED3+: Torsion Spring Drawing with Dimensions
In Quick3, Quick4 and production drawing Quick3, the legs are drawn with dimensions now.
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FED3+: Quick4 and Quick3 Production Drawing with 3D torsion spring

In Quick views, the number of coils or spring length is not visible in the spring drawing on first
glance. Therefore, in the Quick4 view and in the "Production drawing Quick3" a 3D view of the
torsion spring (center line) will be drawn now.
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FED3+: New Price 600 EUR

From now on, new price of FED3+ is 600 euro. For existing customers with FED3+ licenses
nothing changes, you can update the latest version as usua at the update price of 40 euro. Thereis
also no change in the price of packages containing FED3+ (Spring package, Mechanical
Engineering package, complete package).



FED1+ Assembly Space: “Init” row added with initial spring data
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Spring data of the original compression spring have been added at the first row of the table with
optimized springs. This simplifies the comparison of the optimized springs with the initial spring.

FED1+: Expert Mode: Menu simplified for Beginners
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In FED1+, amost all input data was integrated in the Quick Input. Nevertheless, the individual
entries still exist in the menu because of the preference of many users. In order to make the menu
easier for beginners, you can now switch off the expert mode under "Help -> Expert Mode", thenin
"Edit" there are only 5 menu items left (instead of 18). Also, Database, OLE, and some positionsin
the File menu are no longer displayed.

Thismakesit easier for new users and occasional usersto use the program.

Menu Language ¥

GEO2 - Input diameter d or coordinatey
When entering rotation body, you can now input the diameter d instead of the y coordinate.

1 coordinates 4 — O >

mrm <--3 ifch

dem 4
d4 1562 | mm | ¢

arz angle 4-5

1F

] Cancel Help Test B Image




ZARS5 — Effective Face width
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For different face width of the gear wheels, eventually combined with chamfers and center offset,
effective face width used for tooth root fracture calculation (beffY) and for flank pressure
calculation (beffZ) according to 1SO 6336 / DIN 3990 has to be used. The effective tooth width
from the input window with different tooth widths, chamfers and center offset is now correctly
taken over again in the calculation of the pairs sun-planet and planet-ring gear.

SR1: Edit -> Clamping Plates: Insert/Delete Plates with self-defined material data
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When inserting clamping pieces between existing clamping plates under "Edit\ Clamping Plates’,
the permissible pressure against creep pGKr was not taken over, as aresult of which the pGKr
values [11]in the following clamping plates were changed. But only in the case that material data
was entered individually and not selected by database. The bug was corrected in version 23.0.1. The
error only affected users, which

1. do not use the quick input but "Edit \ Clamping Plates"

2. do not select the material from database, but enter material data manually.

3. use the buttons "Insert” and "Delete” under "Edit \ Clamping Plates’.

4. calculation "Creep" activated at “Calculation Method”.



SR1+: Expert Mode

Asin FED1+ you can also switch off "Expert Mode" in SR1 menu, then only the Quick Input is
displayed instead of the individual entries. Thisis clearer and faster. But if you want to enter the
material data of the clamping plates individually or even enter a spring constant for the clamping
plate, you have to switch to expert mode (or remain in expert mode). The programs start with
Expert Mode on.
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Self-defined text in drawings: Configure Layer (or colour)

When entering additional text under “Document\Drawing Info”, you can now also configure the
layer. The colour is assigned to the layer under "File\Settings\Colour". If you configure colour
white, the text will be displayed on the screen (if the background is black), but not printed.
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3D Drawing with/without coordinate system
Until now, a coordinate system has aways been drawn in 3D drawings. This can now be omitted, so
that the actual drawing is more visible.

= FED1+ Compression Spring Softwareto EN138...  — O X

Eile Edit View CAD 5TP STL Database Document OLE Help i TR1 - Girder Calculation - DEMO.tr1 - O *
File Edit View Diagrams CAD 5TL Database Document OLE Help

Tip: Start program (FED1 + floating license) by double-clicking on thefile

Question: Isthere also the possibility to start the program directly from the .fed file? When | try to
open a.fed file by double-clicking or "open with", it does not load the material databases as
configured, asit probably does not know the correct working directory. Is there any possibility
here? The same problem also affects Teamcenter, because we can not start the spring calculation
directly from our folder system and need to save locally and then have to open separately via
HEXAGON.

Answer: Yes, for all users of the network version you have to copy the cfg file from the start folder
or working directory to "CA\HEXAGON\". Or in "C: \HEXAGON\FED1" at FED1+. In these
folders, FED1+ will search the file fedl.cfg with the configuration data if it is not found in the
folder containing the .fed file.

Google Trangdlator Blossoms. “Entreprise de Ressort” isa “Frihlingsgesellschaft”
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Apparently, Google Trandator always trandlates in 2 steps: first everything to English, then to the
target language. The French-to-English trandlation is till correct for “entreprise de ressort”: " Spring
company", the error happens in the second step English-into-German (spring = Frihling).

Vice versy, if you want to trandate "Federfabrik™ into French, nothing happens. Only when you
write with blank "Feder fabrik", the translator displays "fabrique de plumes’, in English "feather
factory".



HEXAGON PRICE LIST 2018-09-01

PRODUCT EUR

DI1 Version 1.2 O-Ring Seal Software 190.-
DXF-Manager Version 9.1 383.-
DXFPLOT V 3.2 123.-
FED1+ V30.7 Helical Compression Springs incl. spring database, animation, relax., 3D,.. 695.-
FED2+ V21.1 Helical Extension Springs incl. spring database, animation, relaxation, ... 675.-
FED3+ V21.0 Helical Torsion Springs incl. prod.drawing, animation, 3D, rectang.wire, ... 600.-
FEDA4 Version 7.7 Disk Springs 430.-
FEDS Version 16.1 Conical Compression Springs 741.-
FEDG6 Version 16.7 Nonlinear Cylindrical Compression Springs 634.-
FED7 Version 13.7 Nonlinear Compression Springs 660.-
FEDS8 Version 7.2 Torsion Bar 317.-
FED9 Version 6.3 Spiral Spring 394.-
FED10 Version 4.3 Leaf Spring 500.-
FED11 Version 3.5 Spring Lock and Bushing 210.-
FED12 Version 2.6 Elastomer Compression Spring 220.-
FED13 Version 4.2 Wave Spring Washers 228.-
FED14 Version 2.2 Helical Wave Spring 395.-
FED15 Version 1.6 Leaf Spring (simple) 180.-
FED16 Version 1.3 Constant Force Spring 225.4
FED17 Version 1.7 Magazine Spring 725.4
GEO1+ V7.3 Cross Section Calculation incl. profile database 294.-
GEO2 V3.2 Rotation Bodies 194.-
GEO3 V3.3 Hertzian Pressure 205.4
GEO4 V5.1 Cam Software 265.-
GEOS5 V1.0 Geneva Drive Mechanism Software 218.-
GEOG6 V1.0 Pinch Roll Overrunning Clutch Software 232.-
GR1 V2.1 Gear construction kit software 185.-
HPGL-Manager Version 9.1 383.-
LG1 V6.6 Roll-Contact Bearings 296.-
LG2 V3.0 Hydrodynamic Plain Journal Bearings 460.-
SR1 V23.1 Bolted Joint Design 640.-
SR1+ V23.1 Bolted Joint Design incl. Flange calculation 750.4
TOL1 V12.0 Tolerance Analysis 506.-
TOL2 Version 4.1 Tolerance Analysis 495.-
TOLPASS V4.1 Library for ISO tolerances 107
TR1 V6.0 Girder Calculation 757.-
WL1+ V21.2 Shaft Calculation incl. Roll-contact Bearings 945.-
WN1 V12.0 Cylindrical and Conical Press Fits 485.-
WN2 V10.1 Involute Splines to DIN 5480 250.-
WN2+ V10.1 Involute Splines to DIN 5480 and non-standard involute splines 380.-
WN3 V 5.4 Parallel Key Joints to DIN 6885, ANSI B17.1, DIN 6892 245.-
WN4 V 4.8 Involute Splines to ANSI B 92.1 276.-
WNS5 V 4.8 Involute Splines to ISO 4156 and ANSI B 92.2 M 255.-
WNS6 V 3.1 Polygon Profiles P3G to DIN 32711 180.-
WN?7 V 3.1 Polygon Profiles PAC to DIN 32712 175.
WN8 V 2.3 Serration to DIN 5481 195,
WN9 V 2.3 Spline Shafts to DIN ISO 14 170.-
WN10 V 4.2 Involute Splines to DIN 5482 260.-
WN11 V 1.3 Woodruff Key Joints 240.-
WN12 V 1.1 Face Splines 256.-
WNXE V 2.2 Involute Splines - dimensions, graphic, measure 375.-
WNXK V 2.1 Serration Splines - dimensions, graphic, measure 230.-
WST1 V 10.2 Material Database 235.-
ZAR1+ V 26.3 Spur and Helical Gears 1115.-
ZAR?2 V8.0 Spiral Bevel Gears to Klingelnberg 792.-
ZAR3+ V9.1 Cylindrical Worm Gears 620.-
ZAR4 V6.0 Non-circular Spur Gears 1610.-
ZAR5 V11.7 Planetary Gears 1355.-
ZARG6 V4.0 Straight/Helical/Spiral Bevel Gears 585.-




ZAR7 V1.5 Plus Planetary Gears 1380.-
ZARS8 V1.4 Ravigneaux Planetary Gears 1950.+
ZARXP V2.4 Involute Profiles - dimensions, graphic, measure 275.4
ZAR1W V2.1 Gear Wheel Dimensions, tolerances, measure 450.-
ZM1.V2.5 Chain Gear Design 326.-
PACKAGES EUR
HEXAGON Mechanical Engineering Package (TOL1, ZAR1+, ZAR2, ZAR3+, ZAR5, ZAR6, WL1+, WN1,
WN2+, WN3, WST1, SR1+, FED1+, FED2+, FED3+, FED4, ZARXP, TOLPASS, LG1, DXFPLOT, GEO1+, 8.500.-
TOL2, GEO2, GEO3, ZM1, WN6, WN7, LG2, FED12, FED13, WN8, WN9, WN11, DI1, FED15, WNXE, !
GR1
HEX?AGON Mechanical Engineering Base Package (ZAR1+, ZAR3+, ZAR5, ZAR6, WL1+, WN1, WST1, 4.900.-
SR1+, FED1,+, FED2+, FED3+) ) !
HEXAGON Spur Gear Package (ZAR1+ and ZARS5) 1,585.-
HEXAGON Planetary Gear Package (ZAR1+, ZAR5, ZAR7, ZARS8, GR1) 3,600.-
HEXAGON Involute Spline Package (WN2+, WN4, WN5, WN10, WNXE) 1,200.-
HEXAGON Graphic Package (DXF-Manager, HPGL-Manager, DXFPLOT) 741.-
HEXAGON Helical Spring Package (FED1+, FED2+, FED3+, FED5, FED6, FED7) 2,550.-
HEXAGON Complete Spring Package (FED1+, FED2+, FED3+, FED4, FEDS5, FED6, FED7, FEDS, FED9, 4,985 -
FED10, FED11, FED12, FED13, FED14,, FED15, FED16, FED17)
HEXAGON Tolerance Package (TOL1, TOL1CON, TOL2, TOLPASS) 945 .-
HEXAGON Complete Package (All Programs) 12,900.-
Quantity Discount for Individual Licenses
Licenses 2 3 4 5 6 7 8 9 >9
Discount % 25% 27.5% 30% 32.5% 35% 37.5% 40% 42.5% 45%
Network Floating License
Licenses 1 2 3 4 5 6 7..8 9.11 >11
Discount/Add.cost -50% -20% 0% 10% | 15% 20% 25% 30% 35%

(Negative Discount means additional cost)

Language Version:

- German and English : all Programs

- French: FED1+, FED2+, FED3+, FED4, FED5, FED6, FED7, FED9, FED10, FED13, FED14, FED15, TOL1, TOL2.
- Italiano: FED1+, FED2+, FED3+, FED4, FEDS5, FED6, FED7, FED9, FED13, FED14, FED17.

- Swedish: FED1+, FED2+, FED3+, FED5, FEDG6, FED?7.

- Portugues: FED1+, FED17

- Spanish: FED1+, FED2+, FED3+, FED17

Updates:

Update prices EUR
Software Update (software Win32/64 + pdf manual) 40.-
Software Update (software 64-bit Win + pdf manual) 50.4

Update Mechanical Engineering Package: 800 EUR, Update Complete Package: 1000 EUR
Maintenance contract for free updates: annual fee: 150 EUR + 40 EUR per program

Hexagon Software Network Licenses
Floating License in the time-sharing manner by integrated license manager
Individual licenses may not be installed in a network!

Conditions for delivery and payment

General packaging and postage costs for delivery on CD-ROM: EUR 60, (EUR 25 inside Europe)
Delivery by Email or download (zip file, manual as pdf files): EUR 0.

Conditions of payment: bank transfer in advance with 2% discount, or by credit card (Master, Visa) net.

Key Code
After installation, software has to be released by key code. Key codes will be sent after receipt of payment.

HEXAGON Industriesoftware GmbH
Stiegelstrasse8  D-73230 Kirchheim Tel. +49 7021 59578, Fax +49 7021 59986
Kieler Strasse 1A D-10115 Berlin Muhlstr. 13 D-73272 Neidlingen

Mobile: +49 163 7342509  E-Mail: info@hexagon.de Web: http://www.hexagon.de
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